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1

Introduction to Oracle ADF Applications

This chapter describes the architecture and key functionality of the Oracle Application
Development Framework and highlights the typical development process for using
JDeveloper 10g Release 3 (10.1.3) to build web applications using Oracle ADF,
Enterprise JavaBeans, Oracle TopLink, and JSE.

This chapter includes the following sections:
= Section 1.1, "Overview of Oracle Application Development Framework"

»  Section 1.2, "Development Process with Oracle ADF and JavaServer Faces"

1.1 Overview of Oracle Application Development Framework

The Oracle Application Development Framework (Oracle ADF) is an end-to-end
application framework that builds on J2EE standards and open-source technologies to
simplify and accelerate implementing service-oriented applications. If you develop
enterprise solutions that search, display, create, modify, and validate data using web,
wireless, desktop, or web services interfaces, Oracle ADF can simplify your job. Used
in tandem, Oracle JDeveloper 10g and Oracle ADF give you an environment that
covers the full development lifecycle from design to deployment, with drag-and-drop
data binding, visual UI design, and team development features built-in.

1.1.1 Framework Architecture and Supported Technologies

In line with community best practices, applications you build using Oracle ADF
achieve a clean separation of concerns by adhering to a model, view, controller
architecture. Figure 1-1 illustrates where each ADF module fits in this architecture.
The core module in the framework is Oracle ADF Model, a declarative data binding
facility that implements the JSR-227 specification. The Oracle ADF Model layer enables
a unified approach to bind any user interface to any business service with no code. The
other modules Oracle ADF comprises are:

»  Oracle ADF Controller integrates Struts and JSF with Oracle ADF Model
»  Oracle ADF Faces offers a library of components for web applications built with JSF

»  Oracle ADF Swing extends Oracle ADF Model to desktop applications built with
Swing

»  Oracle ADF Business Components simplifies building business services for
developers familiar with 4GL tools like Oracle Forms.
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Figure 1-1 Simple ADF Architecture
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1.1.1.1 View Layer Technologies Supported

In the view layer of your application, where you design the web user interface, you
can develop using either classic JavaServer Pages (JSP) or the latest JavaServer Faces
(JSF) standard. Alternatively, you can choose the polish and interactivity of a desktop
UI, and develop using any off-the-shelf Swing components or libraries to ensure just
the look and feel you need. Whatever your choice, you work with WYSIWYG visual
designers and drag-and-drop data binding. One compelling reason to choose JSF is the
comprehensive library of nearly one hundred JSF components that the ADF Faces
module provides.

ADF Faces components include sophisticated features like look and feel "skinning"
and the ability to incrementally update only the bits of the page that have changed
using the latest AJAX programming techniques. The component library supports
multiple JSF render kits to allow targeting users with web browsers and roaming users
with PDA telnet devices. In short, these components dramatically simplify building
highly attractive and functional web and wireless Uls without getting your hands
"dirty" with HTML and JavaScript.

1.1.1.2 Controller Layer Technologies Supported

In the controller layer, where handling page flow of your web applications is a key
concern, Oracle ADF integrates both with the popular Apache Struts framework and
the built-in page navigation functionality included in JSE. In either case, JDeveloper
offers visual page flow diagrammers to design your page flow, and the ADF Controller
module provides appropriate plug-ins to integrate the ADF Model data binding
facility with the controller layer’s page processing lifecycle.

1.1.1.3 Business Services Technologies Supported by ADF Model

In the model layer, Oracle ADF Model implements the JSR-227 service abstraction
called the data control and provides out-of-box data control implementations for the
most common business service technologies. Whichever ones you employ, JDeveloper
and Oracle ADF work together to provide you a declarative, drag-and-drop data
binding experience as you build your user interfaces. Supported technologies include:

»  Enterprise JavaBeans (EJB) Session Beans

Since most J2EE applications require transactional services, EJB session beans are a
logical choice because they offer declarative transaction control. Behind the EJB
session bean facade for your business service, you use plain old Java objects
(POJOs) or EJB entity beans to represent your business domain objects. JDeveloper
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offers integrated support for creating EJB session beans, generating initial session
facade implementations, and creating either Java classes or entity beans. You can
also use Oracle TopLink in JDeveloper to configure the object/relational mapping
of these classes.

s JavaBeans

You can easily work with any Java-based service classes as well, including the
ability to leverage Oracle TopLink mapping if needed.

m  Web Services

When the services your application requires expose standard web services
interfaces, just supply Oracle ADF with the URL to the relevant Web Services
Description Language (WSDL) for the service endpoints and begin building user
interfaces that interact with them and present their results.

» XML

If your application needs to interact with XML or comma-separated values (CSV)
data that is not exposed as a web service, this is easy to accomplish, too. Just
supply the provider URL and optional parameters and you can begin to work with
the data.

»  ADF Application Modules

These service classes are a feature of the ADF Business Components module, and
expose an updateable dataset of SQL query results with automatic business rules
enforcement.

1.1.1.4 Recommended Technologies for J2EE Enterprise Developers

The remainder of this guide focuses attention on using Oracle ADF with the
technologies Oracle recommends to J2EE developers building new web applications:
JavaServer Faces for the view and controller layers, and the combination of an EJB
session bean with mapped Java classes for the business service implementation.
However, this chapter begins with a very simple Oracle ADF application built with
these technologies to acquaint you with typical development process.

Note: If you are a developer coming to J2EE development with
experience in 4GL tools like Oracle Forms, Oracle Designer, Visual
Basic, PowerBuilder, and so on, Oracle recommends that you take
advantage of the additional declarative development features offered
by the Oracle ADF Business Components module. Oracle ADF
Developer’s Guide for Forms/4GL Developers covers using Oracle ADF
with additional framework functionality in the business services tier
using this module. You can access the developer’s guide for
Forms/4GL developers from
http://www.oracle.com/technology/documentation/jdev/
B25947_01/index.html.

1.1.2 Declarative Development with Oracle ADF and JavaServer Faces

For seasoned Java developers, choosing to develop declaratively instead of coding
admittedly takes some getting used to. However, most developers will acknowledge a
true time-saver, and they are also likely to have some exposure to declarative
techniques through their experience with frameworks like Spring or Apache Struts
and tag libraries like the JSP Standard Tag Library (JSTL). JavaServer Faces
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incorporates similar declarative functionality and Oracle ADF complements it by
adding declarative data binding to the mix.

1.1.2.1 Declarative J2EE Technologies You May Have Already Used

Using the Spring Framework, developers configure the instantiation of JavaBeans
through a beans XML file, declaratively specifying dependencies between them. At
runtime, generic framework code reads the XML file, instantiates the beans as
directed, and resolves the dependencies between beans. This design pattern is
commonly known as dependency injection, and Spring provides a declaratively
configured way to leverage its generic implementation to set up your application’s
beans.

Using the Struts struts-config.xml file, developers configure the mapping of
HTTP requests to action handler classes and other page flow information. At runtime,
the generic Struts front-controller servlet uses the information contained in the
configuration XML file to route the requests as directed. When you use Struts, you
leave the request routing to the declaratively configured Struts infrastructure, and
concentrate on writing the interesting code that will handle particular requests.

Using the JSTL tag library, developers indicate the model data to iterate over and
present on the page using declarative expressions, as shown in this snippet:

<c:when test="${not empty UserList}">
<c:forEach var="user" items="${UserList.selectedUsers}">
<tr>
<td><c:out value="${user.name}"/></td>
<td><c:out value="${user.email}"/>
</tr>
</c:forEach>
</c:when>
Rather than resorting to an unmaintainable mix of Java scriptlet code and tags in their
page, developers embed expressions like $ {not empty UserList},
${UserList.selectedUsers}, and ${user.name} into tag attributes. At runtime
a generic expression evaluator returns the boolean-, List- and String-valued
results, respectively, performing work to access beans and their properties without
writing code. This same declarative expression language, nicknamed "EL," that
originally debuted as part of the JSTL tag library has been improved and incorporated
into the current versions of the JSP and JSF standards.

1.1.2.2 JSF Offers Dependency Injection, Page Handling, EL and More

JavaServer Faces simplifies building web user interfaces by introducing web UI
components that have attributes, events, and a consistent runtime APL Instead of
wading knee-high through tags and script, you assemble web pages from libraries of
off-the-shelf, data-aware components that adhere to the JSF standard. As part of
fulfilling their mission to simplify web application building, the industry experts who
collaborated to design the JavaServer Faces standard incorporated numerous
declarative development techniques. In fact, JSF supports all three of the facilities
discussed above: instantiation and dependency injection for beans, page request
handling and page navigation, and use of the standard expression language.

At runtime, the value of a JSF component is determined by its value attribute. While
a component can have static text as its value, typically the value attribute will contain
an EL expression that the runtime infrastructure evaluates to determine what data to
display. For example, an outputText component that displays the name of the
currently logged-in user might have its value attribute set to the expression
#{UserInfo.name} to accomplish this. Since any attribute of a component can be
assigned a value using an EL expression, it’s easy to build dynamic, data-driven user
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interfaces. For example, you could hide a component when a collection of beans you
need to display is empty by setting the component’s rendered attribute to a
boolean-valued EL expression like # {not empty UserList.selectedUsers}.If
the list of selected users in the bean named UserList is empty, then the rendered
attribute evaluates to false and the component disappears from the page.

To simplify maintenance of controller-layer application logic, JSF offers a declarative
bean creation mechanism similar to the Spring Framework. To use it, you configure
your beans in the JSF faces-config.xml file. They are known as "managed beans"
since the JSF runtime manages instantiating them on demand when any EL expression
references them for the first time. JSF also offers a declarative dependency injection
feature. Managed beans can have managed properties whose runtime value is
assigned by the JSF runtime based on a developer-supplied EL expression. Managed
properties can depend on other beans that, in turn, also have managed properties of
their own, and the JSF runtime will guarantee that the "tree" of related beans is created
in the proper order.

As illustrated in Figure 1-2, JSF managed beans serve two primary roles.

Figure 1-2 Basic Architecture of a JSF Application
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Request-scoped managed beans that are tightly related to a given page are known
colloquially as "backing" beans, since they support the page at runtime with properties
and methods. The relationship between a Ul component in the page and the backing
bean properties and methods is established by EL expressions in appropriate attributes
of the component like:

s value="#{expr}"

References a property with data to display or modify
m action="#{expr}"

References a method to handle events
s binding="#{expr}"

References a property holding a corresponding instance of the UI component that
you need to manipulate programmatically — show /hide, change color, and so on.
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Think of managed beans that aren’t playing the role of a page’s backing bean simply as
"application logic beans." They contain code and properties that are not specific to a
single page. While not restricted to this purpose, they sometimes function as business
service wrappers to cache method results in the controller layer beyond a single
request and to centralize pre- or post-processing of business service methods that
might be used from multiple pages.

In addition to using managed beans, you can also write application code in a so-called
PhaseListener class to augment any of the standard processing phases involved in
handling a request for a JSF page. These standard steps that the JSF runtime goes
through for each page are known as the "lifecycle" of the page. Most real-world JSF
applications will end up customizing the lifecyle by implementing a custom phase
listener of some kind, typically in order to perform tasks like preparing model data for
rendering when a page initially displays, among other things.

1.1.2.3 Oracle ADF Further Raises the Level of Declarative Development for JSF

The Oracle ADF Model layer follows the same declarative patterns as other J2EE
technologies, by using XML configuration files to drive generic framework facilities.
The only interesting difference is that ADF Model focuses on adding value in the data
binding layer. It implements the two concepts in JSR-227 that enable decoupling the
user interface technology from the business service implementation: data controls and
declarative bindings.

Data controls abstract the implementation technology of a business service by using
standard metadata interfaces to describe its public interface. This includes information
about the properties, methods, and types involved. At design time, visual tools
leverage the service metadata to let you bind your Ul components declaratively to any
public member of a data control. At runtime, the generic Oracle ADF Model layer
reads the information describing your data controls and bindings from appropriate
XML files and implements the two-way "wiring" that connects your user interface to
your service. This combination enables three key benefits:

= You write less code, so there are fewer lines to test and debug.
= You work the same way with any Ul and business service technologies.
= You gain useful runtime features that you don’t have to code yourself.

There are three basic kinds of binding objects that automate the key aspects of data
binding that all enterprise applications require:

» Action bindings invoke business service methods to perform a task or retrieve data.
»  Iterator bindings keep track of the current row in a data collection.
s Attribute bindings connect Ul components to attributes in a data collection.

Typically UI components like hyperlinks or buttons use action bindings. This allows
the user to click on the component to invoke a business service without code. Ul
components that display data use attribute bindings. Iterator bindings simplify
building user interfaces that allow scrolling and paging through collections of data
and drilling-down from summary to detail information.
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The group of bindings supporting the UI components on a page are described in a
page-specific XML file called the page definition file. Generic bean factories provided by
ADF Model use this file at runtime to instantiate the page’s bindings. These bindings
are held in a request-scoped Map called the binding container accessible during each
page request using the EL expression # {bindings}. This expression always evaluates
to the binding container for the current page. Figure 1-3 shows how EL value binding
expressions relate the Ul components in a page to the binding objects in the binding
container.

Figure 1-3 Bindings in the Binding Container Are EL Accessible at Runtime
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Figure 1-4 illustrates the architecture of a JSF application when leveraging ADF Model
for declarative data binding. When you combine Oracle ADF Model with JavaServer
Faces, it saves you from having to write a lot of the typical managed bean code that
would be required for real-world applications. In fact, many pages you build won’t
require a "backing bean" at all, unless you perform programmatic controller logic that
can’t be handled by a built-in action or service method invocation (which ADF Model
can do without code for you). You can also do away with any application logic beans
that wrap your business service, since the ADF Model’s data control implements this
functionality for you. And finally, you can often avoid the need to write any custom
JSF phase listeners because ADF Model offers a generic JSF phase listener that
performs most of the common operations you need in a declarative way based on
information in your page definition metadata.

Introduction to Oracle ADF Applications 1-7



Overview of Oracle Application Development Framework

Figure 1-4 Architecture of a JSF Application Using ADF Model Data Binding
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1.1.3 Key ADF Binding Features for JSF Development

With the fundamentals of ADF Model data binding for JSF applications described, it’s
time to describe the full breadth of added-value functionality that ADF Model brings
to the table. The following sections give an overview of the key functional areas that
further improve your development productivity.

1.1.3.1 Comprehensive JDeveloper Design-Time Support

JDeveloper’s comprehensive desig- time support for ADF Model declarative data
binding includes:

Data Control Wizards

Quickly create a data control for E]JB session beans, Java service classes, web
services, XML or CSV data from a URL, and ADF application modules. When
additional information is required, helpful wizards guide you step by step.

Data Control Palette

Visualize all business services that you have exposed as data controls and drag
service properties, methods, method parameters, and method results to create
appropriate bound user interface elements. Easily create read-only and editable
forms, tables, master/detail displays, and individual bound UI components
including single and multiselect lists, checkboxes, radio groups, and so on.
Creating search forms, data creation pages, and parameter forms for invoking
methods is just as easy. If your process involves collaboration with page designers
in another team, you can drop attributes onto existing components in the page to
bind them after the fact. In addition to the UI components created, appropriate
declarative bindings are created and configured for you in the page definition file
with robust undo support so you can experiment or evolve your user interface
with confidence that your bindings and UI components will stay in sync.

Page Definition Editor

Visualize page definition metadata in the Structure window and configure
declarative binding properties using the appropriate editor or the Property
Inspector. Create new bindings by inserting them into the structure where desired.
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Binding Metadata Code Insight

Edit binding metadata with context-sensitive, XML schema-driven assistance on
the structure and valid values. Visualize page definition metadata in the Structure
window and configure declarative binding properties using the appropriate editor
or the Property Inspector.

1.1.3.2 More Sophisticated Ul Functionality Without Coding

The JSF reference implementation provides a bare-bones set of basic UI components
that includes basic HTML input field types and a simple table display, but these won't
take you very far when building real-world applications. The ADF Model layer
implements several features that work hand-in-hand with the more sophisticated Ul
components in the Oracle ADF Faces library to make quick work of the rich
functionality your end users crave, including:

More Sophisticated Table Model

Tables are a critical element of enterprise application Uls. By default, JSF doesn’t
support paging or sorting in tables. The ADF Faces table and the ADF Model table
binding cooperate to display pageable, editable or read-only, tables with sorting
on any column.

Key-Based Current Selection Tracking

One of the most common tasks of web user interfaces is presenting lists of
information and allowing the user to scroll through them or to select one or more
entries in the list. The ADF Model iterator binding simplifies tracking the selected
row in a robust way, using row keys instead of relying on positional indicators that
can change when data is refreshed and positions have changed. In concert with the
ADF Faces table and multiselection components, it’s easy to work with single or
multiple selections, and build screens that navigate master /detail information.

Declarative Hierarchical Tree Components and Grids

Much of the information in enterprise applications is hierarchical, but JSF doesn’t
support displaying or manipulating hierarchical data out of the box. The ADF
Model layer provides hierarchical bindings that you can configure declaratively
and use with the ADF Faces tree or hierarchical grid components to implement
interactive user interfaces that present data in the most intuitive way to your
users.

More Flexible Models for Common Ul Components

Even simple components like the checkbox can be improved upon. By default, JSF
supports binding a checkbox only to boolean properties. ADF Model adds the
ability to map the checkbox to any combination of true or valid values your data
may present. List components are another area where ADF Model excels. The
valid values for the list can come from any data collection in a data control and the
list can perform updates or be used for row navigation, depending on your needs.
The ADF Model list binding also makes null-handling easy by optionally adding a
translatable "<No Selection>" choice to the list.
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1.1.3.3 Centralize Common Functionality in Layered Model Metadata

ADF Model can improve the reuse of several aspects of application functionality by
allowing you to associate layered metadata with the data control structure definitions
that can be reused by any page presenting their information. Examples of functionality
that ADF Model allows you to reuse includes:

»  Translatable Prompts, Tooltips, and Format Masks

JSF supports a simple mechanism to reference translatable strings in resource
bundles, but it has no knowledge about what the strings are used for and no way
to associate the strings with specific business domain objects. With ADF Model,
you can associate translatable prompts, tooltips, and format masks with any
attribute of any data type used in the data control service interface so that the
attribute’s data is presented in a consistent, locale-sensitive way on every page
where it appears.

»  Declarative Validation

JSF supports validators that can be associated with a UI component; however, it
offers no mechanism to simplify validating the same business domain data in a
consistent way on every screen where it’s used. With ADF Model, you can
associate an extensible set of validator objects with the data control structure
definition metadata so that the validations will be enforced consistently, regardless
of which page the user employs to enter or modify the object’s data.

»  Declarative Security

JSF has no mechanism for integrating authorization information with Ul
components. With ADF Model, you can associate user or role authorization
information with each attribute in the data control structure definition metadata so
that pages can display the information consistently only to users authorized to see
it.

1.1.3.4 Simplified Control Over Page Lifecycle

JSF rigorously defines the page processing lifecycle, but for some very common tasks it
requires you to write code in your own phase listener to implement it. What’s more,
until a future version of the JSF specification, phase listeners are global in nature,
requiring you to write conditional code based on the current page’s name when the
functionality applies only to a specific page. The ADF Model and ADF Controller
layers cooperate to simplify per-page control over the most common things you would
typically code in a custom phase listener, including:

»  Declarative Method Invocation

Configure business service method invocations with EL expression-based
parameter passing, and bind to method results with options to cache results until
method parameters change to avoid unnecessary requerying of data. You can have
methods invoked by the press of a command component like a link or button, or
configure your page definition to automatically invoke the method at an
appropriate phase of the JSF lifecycle

»  Declarative Page Lifecycle Control

Declaratively configure an iterator binding to refresh its data during a specific JSF
lifecycle phase, and optionally provide a conditional EL expression for finer
control over when that refresh is desired. You have the same control over when
any automatic method invocation should invoke its method as well.
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»  Centralized Error Reporting

Customize the error reporting approach for your application in a single point
instead of on each page.

1.2 Development Process with Oracle ADF and JavaServer Faces

In this section, describes a simple example to acquaint you with the typical
development process of building an Oracle ADF application with JavaServer Faces.
This information is intended as a high-level overview of the basic workflow of ]2EE
application building with Oracle ADF.

1.2.1 Overview of the Steps for Building an Application

Our example is based on a highly-simplified version of the Service Request tracking
system (the SRDemo sample), the real-world sample application used throughout the
remainder of this guide. In the Service Request tracking system, external users log
requests for technical assistance with products they’ve purchased. Internal users try to
assist the customers in the area in which they have expertise. This introduction focuses
on the basics, and examines a small slice of the system’s functionality related to users
and their areas of technical expertise.

You'll examine the steps involved in building a simple JSF page like the one you see in
Figure 1-5 that allows the end user to browse for users by name, scroll through the
results, and for each user found, see their areas of technical expertise.

Figure 1-5 Simple Browse Users Page with Search and Master/Detail Data
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1.2.1.1 Starting by Creating a New Application

The first step in building a new application is to assign it a name and to specify the
directory where its source files will be saved. Selecting Application from the
JDeveloper New Gallery launches the Create Application dialog shown in Figure 1-6.
Here you give the application a name, set a working directory, and provide a package
prefix for the classes you'll create in the application. Suppose that you enter a package
prefix of oracle. srdemo so that, by default, all of the classes will be created in
packages whose names will begin with oracle. srdemo. *. Since you will be
building a web application using JSF, EJB, and TopLink, Figure 1-6 shows the
corresponding application template selected from the list. This application template is
set up to create separate projects named Model and ViewController with appropriate
technologies selected to build the respective layers of the application.
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Figure 1-6 Creating a New Application Using an Application Template
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1.2.1.2 Building the Business Service in the Model Project

You will typically start by building your business service interface, which by default is
done in the project named Model. Your Model project will comprise an EJB 3.0 session
bean to function as the service facade, and Java classes that represent the business
domain objects you need to work with. The model doesn’t need to be functionally
complete to proceed on to the subsequent steps of developing the Ul, but defining the
service interface forces you to think about the data the view layer will need and the
information it may need to supply as parameters to your service methods to complete
the job. Since you'll want to work with users and areas of expertise, the Java classes
named User and ExpertiseArea are created. Each class will contain properties to
reflect the data needed to represent users and areas of expertise.

Based on the requirements, suppose the business service needs to support finding
users by name. For this purpose, you can use the EJB Session Bean wizard to create a
stateless EJB 3.0 session bean using a container-managed transaction. Next you can
add a method called £indUsersByName () to its local interface that accepts the
matching pattern as a parameter called name. To clearly communicate the type of the
result and obtain the best compile-time type checking possible, it is best practice to
declare the return type of the method to be List<User>, a strongly typed list of User
beans. Finally, you can write the method in the SRServiceBean class that
implements the service interface. Figure 1-7 shows what the service and its classes
look like in the Java class diagram in JDeveloper. You can see that the class also
contains the useful £indAllUsers () method to return all users if needed.

Figure 1-7 SRService Session Bean Facade and Supporting Domain Classes
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Because of the clean separation that ADF Model affords between the service and the
user interface, the remaining steps to build the page depend only on the service
interface, not its implementation. You can begin with a service that returns static test
data, but eventually you will want to map the User and ExpertiseArea classes to
appropriate tables in your database. This is where Oracle TopLink excels, and
JDeveloper’s integrated support for configuring your TopLink session and mappings
makes quick work of the task. If you already have database tables with similar
structure to your classes, Oracle TopLink can "automap" the classes to the tables for
you, and then you can adjust the results as needed. If the database tables do not exist
yet, you can use JDeveloper’s database diagrammer to design them before performing
the mapping operation. To implement the findUsersByName () method, you will
create a named query as part of the User mapping descriptor and provide the criteria
required to retrieve users matching a name supplied as a parameter. At runtime, the
Oracle TopLink runtime handles retrieving the results of the parameterized query
from the database based on XML-driven object/relational mapping information.

1.2.1.3 Creating a Data Control for Your Service to Enable Data Binding

With the business service in place, you can begin to think about building the user
interface. The first step in enabling drag-and-drop data binding for the business
service is to create a data control for it. Creating the data control publishes the service
interface to the rest of the Oracle ADF Model design time using JSR-227 service and
structure descriptions. To create a data control, you just drag the SRServiceBean
class onto JDeveloper’s Data Control Palette. Figure 1-8 shows the Data Control
Palette following this operation. You can see it reflects all of the service methods, any
parameters they expect, and the method return types. For the findUsersByName ()
method, you can see that it expects a name parameter and that its return type contains
beans of type User. The nested email, lastName, and expertiseAreas properties
of the user are also displayed. Since expertiseAreas is a collection-typed property
(of type List<ExpertiseArea>), you also see its nested properties. The Operations
folder, shown collapsed in the figure, contains the built-in operations that the ADF
Model layer supports on collections like Previous, Next, First, Last, and so on.

Figure 1-8 Data Control Palette Displays Services Declarative Data Binding
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As you build your application, when you add additional methods on your service
interface or change existing ones, simply drag and drop the SRServiceBean class
again on to the Data Control Palette and the palette—as well as its underlying data
binding metadata—will be refreshed to reflect your latest changes. The data control
configuration information resides in an XML file named DataControls.dcx that
JDeveloper adds to your Model project when you create the first data control. If you
create multiple data controls, the information about the kind of data control they are
(for example E]B, JavaBean, XML, Webservice, and so on.) and how to construct them
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at runtime lives in this file. In addition, JDeveloper creates an XML structure definition
file for each data type involved in the service interface in a file whose name matches
the name of that data type. For an E]B service interface, this means one structure
definition file for the service class itself, and one for each JavaBean that appears as a
method return value or method argument in the service interface.

These structure definition files drive the Data Control Palette display and come into
play when you leverage the declarative, model-layer features like validators, prompts,
tooltips, format masks, and declarative security. Since you defined these features at the
model layer in these structure definition files, all your pages that present information
related to these types display and validate the information in a consistent way.

Figure 1-9 shows all of these files in the Model project in the Application Navigator
after the data control for SRServiceBean has been created.

Figure 1-9 Service Classes and Data Control Metadata Files in Model Project
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1.2.1.4 Dragging and Dropping Data to Create a New JSF Page

With the data control created, you can begin doing drag-and-drop data binding to
create your page. Since you'll be using ADF Faces components in your page, you first
ensure that the project’s tag libraries are configured to use them. Double-clicking the
ViewController project in the Application Navigator brings up the Project Properties
dialog where you can see what libraries are configured on the JSP Tag Libraries page.
If the ADF Faces Components and ADF Faces HTML libraries are missing, you can
add them from here.

Figure 1-10 Configuring ViewController Project Tag Libraries to Use ADF Faces
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Next, you use the Create JSF JSP wizard to create a page called browseusers. jspx.
You may be more familiar working with JSP pages that have a * . jsp extension, but
using a standard XML-based JSP "Document" instead is a best practice for JSF
development since it:

= Simplifies treating your page as a well-formed tree of Ul component tags
s Discourages you from mixing Java code and component tags
= Allows you to easily parse the page to create documentation or audit reports

When the Create JSF JSP wizard completes, JDeveloper opens the new page in the
visual editor. From there, creating the databound page shown in Figure 1-11 is a
completely drag-and-drop experience. As you drop elements from the Data Control
Palette onto the page, a popup menu appears to show the sensible options for Ul
elements you can create for that element.

Figure 1-11 Browse Users JSF Page in the Visual Designer
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The basic steps to create this page are:

1. Drop a panelHeader component from the ADF Faces Core page of the
Component Palette onto the page and set its text attribute in the Property
Inspector to "Browse Users and Expertise Areas".

2. Drop the findUsersByName() method from the Data Control Palette to create an
ADF parameter form. This operation creates a panelForm component containing
the label, field, and button to collect the value of the name parameter for passing
to the method when the button is clicked.

3. Drop the User return value of the findUsersByName() node from the Data Control
Palette to create an ADF read-only form. This operation creates a panelForm
component containing the label and fields for the properties of the User bean.

4. Expand the Operations folder child of the User return value in the Data Control
Palette and drop the built-in Previous operation to the page as a command button.
Repeat to drop a Next button to the right of it.
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5. Drop the expertiseAreas property nested inside the User return value in the Data
Control Palette as an ADF read-only table. Select Enable Sorting in the Edit Table
Columns dialog that appears to enable sorting the data by clicking on the column
headers.

At any time you can run or debug your page to try out the user interface that you've
built.

1.2.1.5 Examining the Binding Metadata Files Involved

The first time you drop a databound component from the Data Control Palette on a
page, JDeveloper will create the page definition file for it. Figure 1-12 shows the
contents of the browseusersPageDef . xml file in the Structure window. You can see
that an action binding named findUsersByName will be created to invoke the service
method of the same name. Iterator bindings named findUsersByNameIter and
expertiseAreasIterator will be created to handle the collection of User beans
returned from the service method and to handle the nested collection of
ExpertiseArea beans. Action bindings named Next and Previous will be created
to support the buttons that were dropped. And finally, attribute bindings of
appropriate names will be created to support the read-only outputText fields and
the table.

Figure 1-12 Page Definition XML File for browseusers.jsp
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The very first time you perform Oracle ADF Model data binding in a project,
JDeveloper creates one additional XML file called DataBindings. cpx that stores
information about the mapping between page names and page definition names and
lists the data controls that are in use in the project. Figure 1-13 shows what the
DataBindings . cpx file looks like in the Structure window. At runtime, this file is
used to create the overall Oracle ADF Model binding context. In addition, page map
and page definition information from this file are used to instantiate the binding
containers for pages as they are needed by the pages the user visits in your
application.
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Figure 1-13 Structure of DataBindings.cpx
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metadata files, see Appendix A, "Reference ADF XML Files".

1.2.1.6 Understanding How Components Reference Bindings via EL

As you perform drag-and-drop data binding operations, JDeveloper creates the
required ADF Model binding metadata in the page definition and creates the JSF
components you've requested. Importantly it also ties the two together by configuring
various properties on the components to have EL expression values that reference the
bindings. Figure 1-14 summarizes how the components on the page reference the
bindings from the page’s binding container at runtime.

Figure 1-14 EL Expressions Related Page Components to Bindings
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As a simple example, take the Previous button. When you drop this built-in operation
as a button, an action binding named Previous is created in the page definition file,
and two properties of the commandButton component are set:

m actionListener="#{bindings.Previous.execute}"
s disabled="#{!bindings.Previous.enabled}"

These two EL expressions "wire" the button to invoke the built-in Previous operation
and to automatically disable the button when the Previous operation does not make
sense, such as when the user has navigated to the first row in the collection.
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Studying another example in the page, like the read-only outputText field that
displays the user’s email, you would see that JDeveloper sets up the following
properties on the component to refer to its binding:

s value="#{bindings.email.inputValue}"
s label="#{bindings.email.label}"

The combination of these two binding attribute settings tells the component to pull its
value from the email binding, and to use the email binding’s 1abel property as a
display label. Suppose you had configured custom prompts for the User and
ExpertiseArea beans in the Model project, the bindings can then expose this
information at runtime allowing the prompts to be referenced in a generic way by
components on the page.

The drag-and-drop data binding steps above did not account for how the current
record display (for example "N of M" ) appeared on the page. Since information about
the current range of visible rows, the starting row in the range, and the total number of
rows in the collection are useful properties available for reference on the iterator
binding, to create this display, just drop three outputText components from the
Component Palette and set each’s value attribute to an appropriate expression. The
first one needs to show the current row number in the range of results from the
findUsersByName method, so it is necessary to set its value attribute to an EL
expression that references the (zero-based!) rangeStart property on the
findUsersByNameIter binding.

#{bindings.findUsersByNameIlter.rangeStart + 1}

The second outputText component just needs to show the word "of", so setting its
value property to the constant string "o£" will suffice. The third outputText
component needs to show the total number of rows in the collection. Here, just a
reference to an attribute on the iterator binding called estimatedRowCount is
needed.

1.2.1.7 Configuring Binding Properties If Needed

Any time you want to see or set properties on bindings in the page definition, you can
select Go to Page Definition in the context menu on the page. For example, you
would do this to change the number of rows displayed per page for each iterator
binding by setting its RangeSize property. In the example shown in Figure 1-14, after
visiting the page definition, the Property Inspector was used to set the RangeSize of
the findUsersByNameIter iterator binding to 1 and the same property of the
expertiseAreasIterator to 2. Setting the RangeSize property for each iterator
causes one user and two expertise areas to display at a time on the page.

1.2.1.8 Understanding How Bindings Are Created at Runtime

The final piece of the puzzle to complete your basic understanding of Oracle ADF
Model involves knowing how your data controls and declarative bindings are created
at runtime based on the XML configuration files you've created. As part of configuring
your project for working with Oracle ADF data binding, JDeveloper registers a servlet
filter called ADFBindingFilter in the web.xml file of your ViewController
project and maps this filter by default to URLs matching the pattern * . jsp and

* . jSpX.

This ADFBindingFilter servlet filter is responsible for finding your
DataBindings. cpx file, based on the information in the web . xm1 file and creating
the ADF binding context. The binding context is a Map that contains all binding
containers, data controls, and the mapping of page names to page definition files. You
can reference it at any time in your application using the EL expression #{data}.It’s
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also the place where the centralized error handler is registered, and APIs are provided
to set a custom error handler if needed (together with numerous other useful APIs).

When the page request is received the application invokes both the JSF lifecycle and
the ADF lifecycle. Specifically, during execution of the ADF lifecycle execution,
another object, the ADFPhaseListener, lazily instantiates the bindings in a binding
container and data controls the first time they are needed to service a page request.
The ADFPhaseListener references the information in the page map on the binding
context to know which binding container to use for which page; it also references
information in the DataControls.dcx file to know what data control factory to use.
On each request, it ensures that the binding container of the current page being
requested is available for reference via EL using the expression # {bindings}.
Figure 1-15 summarizes the relationships between these metadata files.

Figure 1-15 How ADF Binding Metadata Is Used at Runtime
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Once the binding container is set up for a given page, the ADFPhaseListener
integrates the JSF page handling lifecycle with the bindings. It coordinates the
per-page execution of the iterators and service methods based on information in the
appropriate page definition file. The iterators and method invocation bindings are
known as "executable" bindings for this reason.

1.2.2 Making the Display More Data-Driven

After you have a basic page working, you will likely notice some aspects that you'd
like to make more sophisticated. For example, you can use the properties of ADF
bindings to hide or show groups of components or to toggle between alternative sets
of components.
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1.2.2.1 Hiding and Showing Groups of Components Based on Binding Properties
If the application user enters a last name in the browseusers. jspx page that
matches a single user, it doesn’t look very nice to show disabled Next and Previous
navigation buttons and a "1 of 1" record counter. Instead, you might want a result like
what you see in Figure 1-16, where these components disappear when only a single
row is returned.

Figure 1-16 Hiding Panel with Navigation Buttons When Not Relevant

Browse Users and Expertise Areas
Last Mame Contains  |king Go

Last Mame  king
Email Address  steve king@@srdemo.org

Product Level
Microwave Expert

Luckily, this is easy to accomplish. You start by organizing the navigation buttons and
the record counter display into a containing panel component like
panelHorizontal. After creating the panel to contain them, you can drag and drop
in the visual editor, or drag and drop in the Structure window to place the existing
controls inside another container. Then, to hide or show all the components in the
panel, you just need to set the value of the panel’s rendered attribute to a data-driven
EL expression.

Recall that the number of rows in an iterator binding’s collection can be obtained using
its estimatedRowCount property. Figure 1-17 shows the EL picker dialog that
appears when you select the panelHorizontal component, click in the Property
Inspector on its rendered attribute, and click the ... button. If you expand the
bindings for the current page you will see the findUsersByNameIter iterator
binding. You can then expand it further to see the most common properties that
developers reference in EL. By picking est imatedRowCount and clicking the >
button, you can then change the expression to a boolean expression by introducing a
comparison operator to compare the row count to see if it is greater than one. When
you set such an expression, the panel will be rendered at runtime only when there are
two or more rows in the result.
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Figure 1-17 Setting a Panel’s Rendered Attribute Based on Binding Properties
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1.2.2.2 Toggling Between Alternative Sets of Components Based on Binding
Properties

Consider another situation in the sample page. When no rows are returned, by default
the read-only form would display its prompts next to empty space where the data
values would normally be, and the table of experience areas would display the column
headings and a blank row containing the words "No rows yet". To add a little more
polish to the application, you might decide to display something different when no
rows are returned in the iterator binding’s result collection. For example, you might
simply display a "No matches. Try again" message as shown in Figure 1-18.

Figure 1-18 Alternative Display If Search Produces Empty Collection

Browse Users and Expertise Areas
Last Mame Containg:  |kingston (Go )

Mo matches. Try again.

JSF provides a basic feature called a "facet" that allows a Ul component to contain one
or more named, logical groups of other components that become rendered in a specific
way at runtime. ADF Faces supplies a handy switcher component that can evaluate
an EL expression in its FacetName attribute to determine which of its facets becomes
rendered at runtime. Using this component effectively lets you switch between any
groups of components in a dynamic and declarative way. If you group the components
that present the user information and experience area table into a panel, then you can
use the switcher component to switch between showing that panel and a simple
message depending on the number of rows returned.

Figure 1-19 shows the Structure window for the browseusers. jsp page reflecting
the hierarchical containership of JSF components after the switcher component is
introduced. First, you would set up two JSF facets and give them meaningful names
like found and not found. Then you can organize the existing components into the
appropriate facet using drag and drop in the Structure window. In the found facet,
you want a panel containing all of the components that show the user and experience
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area information. In the not found facet, you want just an outputText component
that displays the "No matches. Try again" message.

Figure 1-19 Structure Window View of browseusers.jsp

E browseusers, jsp - Structure E]
4
EHEI Frview z
&-[@] afh:html
----< » afhthead - Browse Users
=-[10 afhi:body
15 afimessages
h:Farm L

» afipanelHeader - Browse Users and Exper...
» af:panelHorizontal
-3 afrinputText - #{bindings. name.inputy. ..
----- @ af:commandButton - Ga
#}-[156] F:facet - separakor
af:objectSeparator
-4 ¥ afswitcher
[S-'=A FiFacet - found
=3 h:panelGraup
¢ > af:paneHorizontal
af:panelForm
g3 afinputText - #{bindings. lastMame.in. ..
=2 af:inputText - #{bindings. email.input. ..
== af:objectSeparator
[=1-[E af:table
E+-E afrcalumn - #4{bindings. Userexperti. .
: A af ioukputText - #{row, product}
Iél B af:column - #4bindings, Useresxperti, .,
b A af ioutputText - #{row. expertiselevel}
= mdl Fifacet - notfound
- A afioutputTesxt - Mo matches, Try again. E

Source | Desi

By setting the facetName attribute of switcher to the EL expression, the found
facet will be used when the row count is greater than zero, and the not found facet
will be used when the row count equals zero:

#{bindings.findUsersByNamelter.estimatedRowCount > 0
?'found': 'notfound'}

The combination of Oracle ADF declarative bindings, ADF Faces components, and EL
expressions demonstrates another situation that previously required tedious, repetitive
coding which now can be handled with ease.

This concludes the introduction to building J2EE applications with Oracle ADEF. The
rest of this guide describes the details of building a real-world sample application
using Oracle ADEF, E]B, and JSF.
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Oracle ADF Service Request Demo Overview

Before examining the individual web pages and their source code in depth, you may
find it helpful to become familiar with the functionality of the Oracle ADF Service
Request demo (SRDemo) application.

This chapter contains the following sections:

»  Section 2.1, "Introduction to the Oracle ADF Service Request Demo"
»  Section 2.2, "Setting Up the Oracle ADF Service Request Demo"

»  Section 2.3, "Quick Tour of the Oracle ADF Service Request Demo"

2.1 Introduction to the Oracle ADF Service Request Demo

The SRDemo application is a realistic customer relationship management sample
application that lets customers of a household appliance servicing company attempt to
resolve service issues over the web. The application, which consists of sixteen web
pages, manages the customer-generated service request through the following flow:

1. A customer enters the service request portal on the web and logs in.
2. A manager logs in and assigns the request to a technician.

3. The technician logs in and reviews their assigned requests, then supplies a
solution or solicits more information from the customer.

4. The customer returns to the site and checks their service request and either closes
the request or provides further information.

5. While a request is open, managers can review an existing request for a technician
and if necessary reassign it to another technician.

Additionally, technicians can identify products in their area of expertise. Managers
then use this information to assign service requests.

After the user logs in, they see only the application functionality that fits their role as a
customer, manager, or technician.
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Technically, the application design adheres to the Model-View-Controller (MVC)
architectural design pattern and is implemented using these existing J2EE application
frameworks:

EJB Session Bean to encapsulate the application services of the entity classes
JavaBean entity classes created from TopLink mappings and database tables
JavaServer Faces navigation handler and declarative navigation rules
Oracle ADF Faces user interface components in standard JSF web pages

Oracle ADF Model layer components to provide data binding

As with all MVC-style web applications, the SRDemo application has the basic
architecture illustrated in Chapter One, "Getting Started with Oracle ADF
Applications".

This document describes in detail the implementation of each of these layers. Each
chapter describes features of Oracle JDeveloper 10g and these technologies to build
distributed web applications.

2.1.1 Requirements for Oracle ADF Service Request Application

The SRDemo application has the following basic requirements:

An Oracle database (any edition) is required for the sample schema.

You must create a database connection named "SRDemo" to connect to the
SRDemo application schema. If you install the SRDemo application using the
Update Center, this connection will have been created for you (see Section 2.2.3,
"Creating the Oracle JDeveloper Database Connection").

The JUnit extension for JDeveloper must be installed. If you install the SRDemo

application using the Update Center, this extension will also be installed for you
(see Section 2.2.5, "Running the Oracle ADF Service Request Demo Unit Tests in
JDeveloper").

2.1.2 Overview of the Schema

Figure 2-1 shows the schema for the SRDemo application.

Figure 2-1 Schema Diagram for the SRDemo Application
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The schema consists of five tables and three database sequences:

USERS: This table stores all the users who interact with the system, including
customers, technicians, and managers. The e-mail address, first and last name,
street address, city, state, postal code, and country of each user is stored. A user is
uniquely identified by an ID.

SERVICE_REQUESTS: This table represents both internal and external requests for
activity on a specific product. In all cases, the requests are for a solution to a
problem with a product. When a service request is created, the date of the request,
the name of the individual who opened it, and the related product are all
recorded. A short description of the problem is also stored. After the request is
assigned to a technician, the name of the technician and date of assignment are
also recorded. All service requests are uniquely identified by an artificial ID.

SERVICE_HISTORIES: For each service request, there may be many events
recorded. The date the request was created, the name of the individual who
created it, and specific notes about the event are all recorded. Any internal
communications related to a service request are also tracked. The service request
and its sequence number uniquely identify each service history.

PRODUCTS: This table stores all of the products handled by the company. For
each product, the name and description are recorded. If an image of the product is
available, that too is stored. All products are uniquely identified by an artificial ID.

EXPERTISE_AREAS: To better assign technicians to requests, the specific areas of
expertise of each technician are define.

The sequences include:

USERS_SEQ: Populates the ID for new users.
PRODUCTS_SEQ: Populates the ID for each product.
SERVICE_REQUESTS_SEQ: Populates the ID for each new service request.

2.2 Setting Up the Oracle ADF Service Request Demo

These instructions assume that you are running Oracle JDeveloper 10g, Studio Edition,
version 10.1.3.x. The application will not work with earlier versions of JDeveloper. To
obtain JDeveloper, you may download it from the Oracle Technology Network (OTN):

http://www.oracle.com/technology/software/products/jdev/index.ht

ml

To complete the following instructions, you must have access to an Oracle database,
and privileges to create new user accounts to set up the sample data.

2.2.1 Downloading and Installing the Oracle ADF Service Request Application

The SRDemo application is available for you to install as a JDeveloper extension. In
JDeveloper, you use the Check for Updates wizard to begin the process of installing
the extension.
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To install the SRDemo application from the Update Center:

1.

If you are using JDeveloper, save your work and close. You will be asked to restart
JDeveloper to complete the update.

Open JDeveloper and choose Help > Check for Updates.

In the wizard, click Next and make sure that Search Update Centers and Internal
Automatic Updates are both selected. Click Next.

Among the available updates, locate Oracle ADF SRDemo Application and select
it. Click Next to initiate the download.

When prompted, restart JDeveloper.

When JDeveloper restarts, select Yes to open the SRDemo Sample application
workspace in the Application Navigator.

JDeveloper displays the SRDemo Sample Schema Install dialog to identify the
database to use for the sample data.

Figure 2-2 SRDemo Application Schema Dialog
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If you want to install the sample data and have access to a SYSTEM DBA account,
enter the connection information in the Sample Install dialog.

Note: The connection information you provide may be for either a local or a
remote database, and that database may be installed with or without an existing
SRDemo schema.

The above process creates a directory samples if one does not exist. The SRDemo
application will appear in the directory <JDEV_
INSTALL>/jdev/sample/SRDemoSample. The Update Center also installs an
extension JAR file in <JDEV_
INSTALL>/jdev/extensions/oracle.jdeveloper.srdemo.10.1.3 which
allows JDeveloper to create the SRDemo application workspace.

2-4 Oracle Application Development Framework Developer’s Guide



Setting Up the Oracle ADF Service Request Demo

2.2.2 Installing the Oracle ADF Service Request Schema

The SRDemo schema is defined in a series of SQL scripts stored in the <JDEV_
INSTALL>/jdev/sample/SRDemoSample/DatabaseSchema/scripts directory.
The schema will automatically be created when you install the application using the
Update Center; however, for manual purposes, you can install or reinstall the schema
in several ways.

Note: You may skip the following procedure if you installed the
SRDemo application using the Update Center in JDeveloper and
proceeded with the schema installer. For details, see Section 2.2.1,
"Downloading and Installing the Oracle ADF Service Request
Application".

Follow these instructions to manually create the SRDemo schema. You may also use
this procedure when you want to refresh the sample data.

To manually install the SRDemo schema:

s From the command line, run the SRDemoInstall.bat/.sh command line script
from the SRDemoSample root directory.

or

= InJDeveloper, open the ANT build file build.xml in the BuildAndDeploy
project and run the setupDB task.

or

s From SQL*Plus, run the build. sqgl script when connected as a DBA such as
SYSTEM.

If the schema already exists, you can also use any of the above methods to delete the
old version of the schema and refresh the sample data. When you install the schema
manually, the following information and questions will appear:

SRDemo Database Schema Install 10.1.3

(c) Copyright 2006 Oracle Corporation. All rights reserved.
This script installs the SRDemo database schema into an
Oracle database.

The script uses the following defaults:

Schema name: SRDEMO

Schema password: ORACLE

Default tablespace for SRDEMO: USERS

Temp tablespace for SRDEMO: TEMP

DBA account used to create the Schema: SYSTEM

If you wish to change these defaults update the file
BuildAndDeploy/build.properties with your values
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What happens next depends on how the demo was installed and what kind of
JDeveloper installation yours is (either FULL or BASE).

s If the SRDemo application was installed manually and is not in the expected
<JDEV_HOME>/jdev/samples/SRDemoSample directory, you will be prompted
for the JDeveloper home directory.

s If JDeveloper is a BASE install (one without a JDK), then you will be prompted for
the location of the JDK (1.5).

s If the SRDemo application was installed using the Update Center into a FULL
JDeveloper install. The task proceeds.

You will next be prompted to enter database information. Two default choices are
given, or you can supply the information explicitly:

Information about your database:

Select one of the following database options:

1. Default local install of Oracle Personal, Standard or Enterprise edition
Host=localhost, Port=1521, SID=ORCL

2. Default local install of Oracle Express Edition
Host=localhost, Port=1521, SID=XE

3. Any other non-default or remote database install

Choice [1]:

If you choose 1 or 2, the install proceeds to conclusion. If you choose 3, then you will

need to supply the following information: (defaults shown in brackets)

Host Name or IP Address for your database machine [localhost]:
Database Port [1521]:

Database SID [orcl]:

The final question is for the DBA Account password:

Enter password for the SYSTEM DBA account [manager]:
The install then runs.

2.2.3 Creating the Oracle JDeveloper Database Connection

You must create a database connection called "SRDemo" to connect to the sample data
schema. If you installed the SRDemo application using the Update Center, this
connection will have been created for you.

Note: You may skip the following procedure if you installed the
SRDemo application using the Update Center in JDeveloper. In that
case, the database connection will automatically be created when you
download the application.

Follow these instructions to manually create a new database connection to the Service
Request schema.

To manually create a database connection for the SRDemo application:
1. In]JDeveloper, choose View > Connections Navigator.

2. Right-click the Database node and choose New Database Connection from the
context menu.

3. Click Next on the Welcome page.
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4. Inthe Connection Name field, type the connection name SRDemo. Then click
Next.

Note: The name of the connection (SRDemo) is case sensitive and must be typed
exactly to match the SRDemo application’s expected connection name.

5. On the Authentication page, enter the following values. Then click Next.
Username: SRDEMO
Password: Oracle
Deploy Password: Select the checkbox.

6. On the Connection page, enter the following values. Then click Next.
Host Name: localhost
JDBC Port: 1521
SID: ORCL

7. Click Test Connection. If the database is available and the connection details are
correct, then continue. If not, click the Back button and check the values.

8. Click Finish. The connection now appears below the Database Connection node
in the Connections Navigator.

You can now examine the schema from JDeveloper. In the Connections Navigator,
expand Database > SRDemo. Browse the database elements for the schema and
confirm that they match the schema definition described in Section 2.1.2, "Overview of
the Schema".

2.2.4 Running the Oracle ADF Service Request Demo in JDeveloper

If you installed the SRDemo application using the Update Center, choose Help > Open
SRDemo Application Workspace to open the application workspace.
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= Run the application in JDeveloper by selecting index.jspx in the UserInterface
project and choosing Run, as shown in Figure 2-3.

Figure 2-3 Running the SRDemo Application in JDeveloper
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Tip: The UserInterface project defines index. jspx to be the default
run target. This information appears in the Runner page of the Project
Properties dialog for the UserInterface project. This allows you to
simply click the Run icon in the JDeveloper toolbar when this project
is active, or right-click the project and choose Run. To see the project’s
properties, select the project in the navigator, right-click, and choose
Property Properties.

Running the index. j spx page from inside JDeveloper will start the embedded
Oracle Application Server 10g Oracle Containers for J2EE (OC4J) server, launch your
default browser, and cause it to request the following URL:

http://130.35.103.198:8988/SRDemo/faces/app/SRWelcome. jspx

If everything is working correctly, the index . jspx page’s simple scriptlet
response.sendRedirect ("faces/app/SRWelcome. jspx"), will redirect to
display the login page of the SRDemo application, as shown in Figure 2—4.
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Figure 2-4 SRWelcome.jspx: SRDemo Login Page
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See Section 2.3, "Quick Tour of the Oracle ADF Service Request Demo" to become
familiar with the web pages that are the subject of this developer’s guide.
Additionally, read the tour to learn about ADF functionality used in the SRDemo
application and to find links to the implementation details documented in this guide.

2.2.5 Running the Oracle ADF Service Request Demo Unit Tests in JDeveloper

You must ensure that the JUnit Extension for JDeveloper is installed. JUnit is the
standard tool for building regression tests for Java applications. Go to the JUnit home
page at http:/ /www.junit.org/index.htm for further details.

Oracle JDeveloper 10g features native support for creating and running JUnit tests, but
this feature is installed as a separately downloadable JDeveloper extension. You can
tell if you already have the JUnit extension installed by choosing File > New from the
JDeveloper main menu and verifying that you have a Unit Tests (JUnit) category
under the General top-level category in the New Gallery.
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Figure 2-5 Running the SRDemo Unit Tests in JDeveloper
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If you do not already have the JUnit extension installed, then use the Update Center in
JDeveloper.

Note: You may skip the following procedure if you installed the
SRDemo application using the Update Center in JDeveloper. In that
case, the JUnit extension will automatically be installed when you
download the application.

To install the JUnit extension from the Update Center:

1. If you are using JDeveloper, save your work and close. You will be asked to restart
JDeveloper to complete the update.

2. Open JDeveloper and choose Help > Check for Updates.

3. Inthe wizard, click Next and make sure that Search Update Centers and Internal
Automatic Updates are both selected. Click Next.

4. Among the available updates, locate JUnit Integration 10.1.3.xx and select it. Click
Next to initiate the download.

5. When prompted, restart JDeveloper.

6. When JDeveloper restarts, the new extension will be visible in the Unit Tests
category in the New Gallery.

2.3 Quick Tour of the Oracle ADF Service Request Demo

The SRDemo application is a realistic web portal application that allows customers to
obtain appliance servicing information from qualified technicians. After the customer
opens a new service request, a service manager assigns the request to a technician with
suitable expertise. The technician sees the open request and updates the customer’s
service request with information that may help the customer solve their problem.

The application recognizes three user roles (customer, manager, and technician). Roles
are determined based on standard J2EE container managed security features of the
Oracle Application Server. As the following sections show, the application features
available to the user depend on the user’s role.
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2.3.1 Customer Logs In and Reviews Existing Service Requests

Log in as the customer:
s Username: dfaviet
s Password: welcome

To enter the web portal click the Start button.

This action displays the customer’s list of open service requests, as shown in
Figure 2-6.

Figure 2-6 SRList.jspx: List Page for a Customer
My Service Requests

Select and | Mew

Request Requested Assigned
Soloct Id Status On Problem on
® (113 Open Dec 18, I'm getting & strarge [t
2005 clicking sound when e amsigned
washer enters full spin vt
o (114 Open Dec 18, There seems to be a further Not
2005 problem, Teen'tszem o assigoed

coen the door for 5 minutes vet
after the washer cvcla has

firishied
O (204 Open Dec 21, The dryear |5 spitting out Pt
05 buge chiurkes of [irt acsiged

vet

When you log in as the customer, the list page displays a menu with only two tabs,
with the subtabs for My Service Requests selected.

SEMCIGE MeyUuests ruria

My Service Reqguests Mewy Service Request

Open Paquests | Requests dmaing Customer | Clised Requests Al Requests  Craabe Mew Sarvice Request

Note that additional tabs will be visible when you log in as the manager or technician.
Select the menu subtab All Requests to display both closed and open requests.

To browse a description of any request, select the radio button corresponding to the
row of the desired request and click View.

The same operation can also be performed by clicking on the service request link in
Request Id column.

The customer uses the resulting page to update the service request with their response.
To append a note to the current service request, click Add a note.
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Figure 2-7 shows an open service request selected by a customer and the note they are
about to append. Notice that the buttons above the text input field appear disabled to
prevent the user from selecting those operations until the task is completed. Below the
note field, is the list of previous notes for this master service request.

Figure 2—-7 SRMain.jspx: Main Page for a Customer

Logged in as dfaviet
Sarvice Request Information for SR # 100

Product Washing Machine W001

Feouested Bv: Daniel Faviet

Azeigred To: Alexander Hunold

Problem: T have noticed that every time I da a wash there s a pool

[shote:
[actl] [cancel ] [ clear Feios |
Crabe Type Mot
D 15, TechriclanHad cistosner check hooas B0 see if thay are leaking
2003
Diex 16, Cistomer Buerything wiorks it weas e hose b washing machine
2005 cornECton

Where to Find Implementation Details

The Oracle ADF Developers Guide describes the following major features of this
section.

»  Using dynamic navigation menus: The menu tabs and subtabs which let the user
access the desired pages of the application, are created declaratively by binding
each menu component to a menu model object and using the menu model to
display the appropriate menu items. See Section 11.2, "Using Dynamic Menus for
Navigation".

» Displaying data items in tables: The list of service requests is formatted by a Ul
table component bound to a collection. The Data Control Palette lets you easily
drop databound components into your page. See Section 7.2, "Creating a Basic
Table".

» Displaying a page by passing parameter values: The user may select a service
request from the list of open requests and edit the details in the edit page. The
commandLink is used to both navigate to the detail page and to send the
parameters that the form creation method uses to display the detail page data. See
Section 10.4, "Passing Parameter Values to Another Page Using a Command
Component".

= Using a method with parameters to create a form: The user drills down to a
browse form that gets created using a finder method from the service. Instead of
the method returning all service requests, it displays only the specific service
request passed by the previous page. See Section 10.6, "Creating a Form or Table
Using a Method that Takes Parameters".

» Displaying master-detail information: The user can browse the service history for
a single service request in one form. The enter form can be created using the Data
Control Palette. See Section 8.3, "Using Tables and Forms to Display Master-Detail
Relationships".
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2.3.2 Customer Creates a Service Request

To create a new service request, select the New Service Request tab.

My Serwics Aeguests H:llr Service Reguest

Logged in as dfaviet

This action displays the first page of a two-step process train for creating the service
request. Figure 2-8 shows the first page.

Figure 2-8 SRCreate.jspx: Step One, Create-Service-Request Page

Biasic Prablem Details Condir Logged in as dfaviet

Create New Sarvice Request
cneel | | Basic Problem Detals (v | Sntinue

Have you checked the fr- ok Ot
Enter 2 fasiz nﬁ::ncr:pﬁun ofyuurpm.bui_-m, be sure to include any
information that you believe will be useful for the technician

L. Select your spd igne: ¥

Washirg Madhine W01 &
Washirg Machine Wl3a
Washirg Mad-ine wioi1y
Washirg Madhine To0S
IWasher Cryer Waold
Washer Cirver WOD3 d
2. Cescribe the problem: *

Canoal | |Basic Problem Details = | [ Sontrus
The input fields that your page displays can raise validation errors when the user fails

to supply required information. To see a validation error, click the Logout menu item
before entering a problem description for the new service request.

& | ogout

Figure 2-9 shows the validation error that occurs in the create-service-request page
when the problem description is not entered. Notice the text below the field that raised
the validation error directs the user to enter a description.
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Figure 2-9 SRCreate.jspx: Step One Validation Error in Page

Bacic Problam Datalle Confion Logged in as dfaviet

i Error
- Wale regared.

Create New Service Request

[Coreel | |Baskc Problem Details | [Sortirue |

Hawe you checked the Freouently Asked Duesiiors
Enter a fask description of pour problem, be sure to include any
information that you believe wil be useful for the technician

L. Salect wour sppliance: & =kl Machis Wiol B8
Wzshirg Machime W003a
\Weehirg Machise W07
Weehirg Machire TO0S
Wizsher Dryer WoO1d
Wisgher Dryer WO03d =
2. Deseribe the problem:  Xxx

Flease anter @ problen desoription to procaed

You can see another way of handling validation errors by clicking the Continue button
before entering a problem description.

Figure 2-10 shows the validation error that displays within a dialog when the problem
description is not entered. Notice the text below the field that raised the validation
error directs the user to enter a description.

Figure 2-10 SRCreate.jspx: Step One Validation Error in Separate Dialog

Microsoft Internet Explorer |E|

Form walidation failures:
! - Pleasze erter & probkem descripton o procesd

[ = |

To proceed to the next page of the process train, first type some text into the problem
description field, then either choose Confirm from the dropdown menu or click the
Continue button.

Bsic Problemn Details « | [ cartnue

|Basic Frioplem Details

In the next step, the customer confirms the information is correct before submitting the
request to the data source. Figure 2-11 shows the final page. Notice that the progress
bar at the top of the page identifies Confirm is the last step in this two-page
create-service-request process chain.
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Figure 2-11 SRCreateConfirm.jspx: Step Two, Create-Service-Request Page
Basic Problem Detalls Confir Logged in as dfaviet

Create New Service Request
[ carcal | [Back ] |Corfirm w [ Zubink Reguest

Check the details of your problem. If they are correct press Submit
Request, otherwise press Back to makes an amendment.

_ 1, Your 1d: dfawviat

2 Appliance; Washimg Madhine W01

.3. Problam Desoription: Machine wabbles excesgively,

| carcal | [Back | |Corfirm w | Submit Repuest

Click the Back button to returns to the create-service-request page.

Click the Submit Request button to enter the new service request into the database. A
confirmation page displays after the new entry is created.

Submit Fequest

To continue the application as the manager role, click the Logout menu item to return
to the login page.

& | ogout

Where to Find Implementation Details

The Oracle ADF Developers Guide describes the following major features of this
section.

»  Creating a new record: The user creates a new service request using a form that
commits the data to the data source. JDeveloper lets you create default constructor
methods on the service as an easy way to drop record creation forms.
Alternatively, custom methods on the service may be used. See Section 10.7,
"Creating an Input Form for a New Record".

= Multipage process: The ADF Faces components processTrain and
processChoiceBar guide the user through the process of creating a new service
request. See Section 11.5, "Creating a Multipage Process".

= Showing validation errors in the page: There are several ways to handle data-entry
validation in an ADF application. You can take advantage of validation rules
provided by the ADF Model layer. See Section 12.3, "Adding Validation".

= Handling page navigation using a command button: The application displays the
appropriate page when the user chooses the Cancel or Submit button. Navigation
rules, with defined outcomes, determine which pages is displayed after the button
click. See Section 9.1, "Introduction to Page Navigation Using Outcomes".
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2.3.3 Manager Logs In and Assigns a Service Request

Log in as the manager:
s User name: sking
s Password: welcome

Click the Start button.

This action displays the manager’s list of open service requests. The list page displays
four menu tabs, with the subtabs for the My Service Requests tab selected.

CME Corporation & Logout BHelp
Service Requests Portal

My Service Requesks Advanced Sasrch | Mewy Sercrs Peguest | Hanagement

Requests A ting Cebomer Clogsd Aegussts ol Requssts

Open Regests reshs Hew S=rars Feguest

Logged in as sking

To see a description of any request, select a radio button corresponding to the row of
the desired request and click View.

Figure 2-12 shows an open service request. Notice that when logged in as the
manager, the page displays an Edit button and a Delete Service History Record
button. These two operations are role-based and only available to the manager.

Figure 2-12 SRMain.jspx: Main Page for a Manager

Logged in as sking
Service Request Information for SR # 111
Frizzict: Fridge Freezar FZ007s St Open
Reruestedi By: Shelley Higgins Cro 1271772005
Assigred Tor Steven King On: 12/18/2005
Froiem: Defraster s not working properly
(Edt] [_Cebte Servicereguest | [ addanote | [ Upiced adomument |

Seleck and ... [ Dess Gervice Helory Recod |

Sokact Al | Seloct Mone
Select Date T yee MNote
[0 Cwec 18, 2005 Technkzlan  Fefering bo rod-eshooting mearual

To edit the current service request, click Edit.

Figure 2-13 shows the detail edit page for a service request. Unlike the page displayed
for the technician, the manager can change the status and the assigned technician.
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Figure 2-13 SREdit.jspx: Edit Page for a Manager

Logged in as sking
Edit Service Request

Fequest Id 111

Created By:  Shelley Higdine
Fequested On [ec 17, 2005
Asiged b0 Steven King
Statis

Fratdem

To find another technician to assign, click the symbol next to the assigned person’s
name.

4

e
-

Figure 2-14 shows the query by criteria search page that allows the manager to search
for staff members (managers and technicians). This type of search allows wild card
characters, such as the % and * symbols.

Figure 2—-14 SRStaffSearch.jspx: Staff Search Page for a Manager

Search for Staff

First Mame: . |
Liast Mame: |
Emaill Adoress: |
Fala: =y role

Crhectnician

Crmanane

Caval |
Select |
Select Name Email Address Fode

@ Shaven king =king Manzger
O Alewande Hunold aunold technician
O BroceEmsk bemret echnilcian
O Dawid A_etim et bechinician
1 alli Pataballa eakatal echnlcian
O Cana Lorenz dicrentz fEchnician

To assign another staff member to this service request, click the selection button next to
the desired staff’s name.

®

To update the open service request with the selected staff member, click the Select
button.

E=)
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Where to Find Implementation Details

The Oracle ADF Developers Guide describes the following major features of this
section.

= Databound dropdown lists: The ADF Faces component selectOneChoice
allows the user to change the status of the service request or to pick the type of
service request to perform a search on. See Section 11.7, "Creating Databound
Dropdown Lists".

s Searching for a record: The user can search existing service requests using a
query-by-example search form. In this type of query, the user enters criteria info a
form based on known attributes of an object. Wild card search is supported. See
Section 10.8, "Creating Search Pages".

= Using a popup dialog: At times you may prefer to display information in a
separate dialog that lets the user postback information to the page. The search
window uses a popup dialog rather than display the search function in the page.
See Section 12.7, "Displaying Error Messages" and Section 11.3, "Using Popup
Dialogs".

= Using Partial Page Rendering: When the user clicks the flashlight icon (which is a
commandLink component with an objectImage component), a popup dialog
displays to allow the user to search and select a name. After selecting a name, the
popup dialog closes and the Assigned to display-only fields are refreshed with the
selected name; other parts of the edit page are not refreshed. See Section 11.4,
"Enabling Partial Page Rendering".

= Using managed bean to store information: Pages often require information from
other pages in order to display correct information. Instead of setting this
information directly on a page, which essentially hardcodes the information, you
can store this information on a managed bean. For example, the managed bean
allows the application to save the page which displays the SREdit page and to use
the information in order to determine where to navigate for the Cancel action. See
Section 10.2, "Using a Managed Bean to Store Information".

= Passing parameters between pages: The commandLink component is used to both
navigate to the SREdit page and to set the needed parameter for the
findServiceRequestById (Integer) method used to create the form that
displays the data on the SREdit page. You can use the ADF Faces
setActionListener component to set parameters. See Section 10.4, "Passing
Parameter Values to Another Page Using a Command Component".

2.3.4 Manager Views Reports and Updates Technician Skills

To access the manager-only page, select the Management tab.

b Mew Service Requsst Management

Logged in as sking

This action displays the staff members and their service requests in a master-detail
ADF Faces tree table component. Figure 2-15 shows the tree table with an expanded
technician node.
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Figure 2-15 SRManage.jspx: Management Reporting Page

TEEE: DETVICE HEqUEesTS Forar
= My Service Azquests  advenced Seanch MewService Regquest BERRTTG TSt

Cwervima Techrician Shills

Logged in as sking
Management Reporting

Staff with Open/Pending issues

[0 Shever Kirg
¥ Aleegacer Hnold
[Cpen] Cefroster s rat wiorking
- properly
0 [Open] Lryer s spitting cut lots of

lirit.
O Briee Brrst
O Dareied st

0O walll Pataballa

Each child node in the tree table is linked to a detail service request report. Click the
child node link Defroster is not working properly to display the detail:

Logged in as sking
Management Reporting

Staff with Open/Pending issues Problem History for Service Request 111

E i%wm K""H y Open - Created o0 Deramber 17 X¥75 852 AM
[=3if= | dg' LIMi2)
[ n]— , , Cormplete Problem Text:
O pen ] Defroster i3 nobweorking

Eroperly Diefroeter is mat working properly
0 [Open] Dryer is snitting out lots of
lirt.
[ Bruce Frmst
O Ceavid Auistin
O Valll Pataballa

Each staff name is linked to a detail of the staff member’s assigned skills. Click the
staff name link Alexander Hunold to display the list of assigned skills:

Logged in as sking
Management Repaorting

Staff with Open/Pending issues Skills information for Alexander Hunold
i Product Area Expertise Level

L steven King Cirver L0032 Cualified
¥ Llevarder Horold , Dryer D011 Qualified

O [':T:'Eﬂll Cefroster is nobworking Dryer 2000 Oualified

Eﬁﬁt . { Wssher Dryer WOOIdEpart

O linkE. Wizeher Drver WO 3d0uslified
O Cravid Austin
0 Yalll Patebella

To access the skills assignment page, select the Technician Skills subtab.
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Cweriden  Techrician Skilks

Logged in as sking

This action displays a staff selection dropdown list and an ADF Faces shuttle
component. Figure 2-16 shows the shuttle component populated with the skills of the
selected staff member.

Figure 2-16 SRSkills.jspx: Technician Skills Assignment Page

EETT=IT T SETEILE MEYUESLS FurLar
- My Service Requssts Adwanced Search Nevd Service Reguest Management

Oweriew  Technidan Skik

Logged in as sking
Technician Skills
Feview Skils assigned to | Alsxands Hunald b

Avallable Products Assigned skills
Washirg Machime W1 = Ciryer D003
Washirg Machine WiO03Za Crye D011
Washirng Machine Wiols Crper 2000
WWashirg Mackime TODE Washer Cryer WOO01d
Fridge FOL1= Washer Dryes IWO030
Fricge FIL 1w 0 Washer Cryer W0 170
Fridge FOL1b il Wi
Fridge 0w Ml A
Fridge Freszer FZ0075 Y
Fridge Freszer F2O0 7w -
Freezer 70025 Remove All
Fraerer SO0 w -
Lescription Cescription

| Sawe kil changes |

Use the supplied Move, Move All, Remove, or Remove All links to shuttle items
between the two lists. The manager can make multiple changes to the Assigned Skills
list before committing the changes. No changes t